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Manuals for This Machine
Read this manual carefully before you use this machine.

Refer to the manuals that are relevant to what you want to do with the machine.

• Media differ according to manual.

• The printed and electronic versions of a manual have the same contents.

• Adobe Acrobat Reader/Adobe Reader must be installed in order to view the manuals as PDF files.

• A Web browser must be installed in order to view the html manuals.

About This Machine

Before using the machine, be sure to read the section of this manual entitled Safety Information.

This manual introduces the machine's various functions. It also explains the control panel, preparation
procedures for using the machine, how to enter text, how to install the CD-ROMs provided, and how
to replace paper, toner, staples, and other consumables.

Troubleshooting

Provides a guide for resolving common usage-related problems.

Copy and Document Server Reference

Explains Copier and Document Server functions and operations. Also refer to this manual for
explanations on how to place originals.

Facsimile Reference

Explains Facsimile functions and operations.

Printer Reference

Explains Printer functions and operations.

Scanner Reference

Explains Scanner functions and operations.

Network and System Settings Reference

Explains how to connect the machine to a network, configure and operate the machine in a network
environment, and use the software provided. Also explains how to change User Tools settings and
how to register information in the Address Book.

Security Reference

This manual is for administrators of the machine. It explains security functions that you can use to
prevent unauthorized use of the machine, data tampering, or information leakage. For enhanced
security, we recommend that you first make the following settings:

• Install the Device Certificate.

• Enable SSL (Secure Sockets Layer) Encryption.
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• Change the user name and password of the administrator using Web Image Monitor.

For details, see "Setting up the Machine", Security Reference.

Be sure to read this manual when setting the enhanced security functions, or user and administrator
authentication.

PostScript 3 Supplement

Explains how to set up and use PostScript 3.

VM Card Extended Feature Settings Device Reference

Explains how to set up the extended features settings with the machine.

VM Card Extended Feature Settings Web Reference

Explains how to set up the extended features settings using Web Image Monitor.

Other manuals

• UNIX Supplement

• Quick Reference Copy Guide

• Quick Reference Printer Guide

• Quick Reference Fax Guide

• Quick Reference Scanner Guide

• App2Me Start Guide

• Manuals provided are specific to machine types.

• For "UNIX Supplement", please visit our Web site or consult an authorized dealer. This manual
includes descriptions of functions and settings that might not be available on this machine.
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Notice

Important

In no event will the company be liable for direct, indirect, special, incidental, or consequential damages
as a result of handling or operating the machine.

For good copy quality, the manufacturer recommends that you use genuine toner from the manufacturer.

The manufacturer shall not be responsible for any damage or expense that might result from the use of
parts other than genuine parts from the manufacturer with your office products.
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates points to pay attention to when using the machine, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

Indicates supplementary explanations of the machine's functions, and instructions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[ ]
Indicates the names of keys on the machine's display or control panels.

Notes

Contents of this manual are subject to change without prior notice.

Colors on color keys or the color circle may differ slightly from the colors of actual copies.

Two kinds of size notation are employed in this manual.

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Depending on which country you are in, certain units may be optional. For details, please contact your
local dealer.

About IP Address

In this manual, “IP address” covers both IPv4 and IPv6 environments. Read the instructions that are relevant
to the environment you are using.
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Laws and Regulations

Legal Prohibition

Do not copy or print any item for which reproduction is prohibited by law.

Copying or printing the following items is generally prohibited by local law:

bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing certain
items, consult with your legal advisor.

This machine is equipped with a function that prevents making counterfeit bank bills. Due to this function
the original images similar to bank bills may not be copied properly.
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1. Windows Configuration
This chapter explains how to install and configure the printer drivers for use on the Windows operating
system.

Using the Standard TCP/IP Port
This section explains how to install the PostScript 3 printer driver for use on the Standard TCP/IP port.

Installing the PostScript 3 Printer Driver (Windows 2000)

This section explains how to install the PostScript 3 printer driver under Windows 2000 for use on the
Standard TCP/IP port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor for
Client port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Select [Standard TCP/IP Port], and then click [Next >].

9. Click [Next >].

10. Enter the machine name or IP address in the [Printer Name or IP Address] box, and then
click [Next >].

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

11
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11. Click [Finish].

12. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

13. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

14. Specify whether or not to share the machine, and then click [Next >].

15. Specify whether or not to print a test page, and then click [Next >].

16. Click [Finish].

If the [Digital Signature Not Found] message appears, click [Yes].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 /
2003 R2)

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003 /2003 R2 for use on the Standard TCP/IP port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor for
Client port.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

1. Windows Configuration
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3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Click [Create a new port:].

8. Click [Standard TCP/IP Port] in [Type of port:], and then click [Next >].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

10. Enter the machine name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

11. Click [Next >].

12. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

14. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

15. Specify whether or not to share the machine, and then click [Next >].

16. Specify whether or not to print a test page, and then click [Next >].

17. Click [Finish].

If the [Hardware Installation] message appears, click [Continue Anyway].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Using the Standard TCP/IP Port
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Installing the PostScript 3 Printer Driver (Windows Vista/7, Windows Server
2008)

This section explains how to install the PostScript 3 printer driver under Windows Vista/7 or Windows
Server 2008 for use on the Standard TCP/IP port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor for
Client port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Click [Create a new port:], and then select [Standard TCP/IP Port] in [Type of port:].

7. Click [Next].

8. Select [TCP/IP Device] in [Device type].

9. Enter the machine's IP address in [Hostname or IP address:], and then click [Next].

The [Port name:] text box automatically obtains a port name. Change this name if necessary.

A printer driver installation screen appears when Standard TCP/IP port is detected.

10. Check that the name of the machine whose driver you want to install is selected, and then
click [Next].

11. Change the machine name if you want, and then click [Next].

If a check box for setting the machine as a default printer appears, configure as necessary.

1. Windows Configuration
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If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

12. Specify whether or not to share the machine, and then click [Next].

13. Specify whether or not to print a test page, and then click [Finish].

If a check box for setting the machine as a default printer appears, configure as necessary.

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• Depending on your computer's operating system, the [AutoPlay] dialog box may appear. If this
happens, click [Run SETUP.EXE]. If the [User Account Control] dialog box appears, click [Yes] or
[Continue] to allow the auto play program to run.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Using the Standard TCP/IP Port
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Using the IPP Port
This section explains how to install the PostScript 3 printer driver for use on the IPP port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

• In an IPv6 environment, you cannot use the IPP Port. Use the SmartDeviceMonitor for Client port.

• The IPP port cannot be used under Windows 2000. If you are using Windows 2000, install the
PostScript 3 printer driver using the SmartDeviceMonitor for Client port. To use the
SmartDeviceMonitor for Client port, you must first download SmartDeviceMonitor for Client from the
manufacturer's Web site. For details about the SmartDeviceMonitor for Client port, see "Using the
SmartDeviceMonitor for Client Port".

• To print via IPP-SSL, use the SmartDeviceMonitor for Client port.

• To print via IPP-SSL under Windows Vista/7 or Windows Server 2008/2008 R2, you must install
the certificate on your computer before you install the printer driver using the IPP port. For details,
consult your administrator.

• p.26 "Using the SmartDeviceMonitor for Client Port"

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003/
2003 R2)

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003/2003 R2 for use on the IPP port.

1. Quit all applications currently running.

2. On the [Start] menu, click [Printers and Faxes].

3. Click [Add a printer].

The [Add Printer Wizard] dialog box appears.

4. Click [Next>].

5. Click [A network printer, or a printer attached to another computer].

6. Click [Next>].

7. Click [Connect to a printer on the Internet or on a home or official network:].

1. Windows Configuration
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8. In the [URL:] box, enter "http:// machine's IP address/printer (or ipp)" as the machine's
address, and then click [Next>].

9. Click [Have Disk...].

10. Insert the provided CD-ROM into the computer's CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

11. Click [Browse...], and then specify a location for the INF file.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1".

12. Click [Open].

13. Click [OK] to close the Install From Disk window.

14. Select the machine you want to use, and then click [OK].

If the [Hardware Installation] message appears, click [Continue Anyway].

15. Configure the default printer as necessary, and then click [Next >].

16. Click [Finish].

If installation is successful, the icon of the printer connected to the IPP port is added to the [Printers
and Faxes] window.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

Installing the PostScript 3 printer driver (Windows Vista/7, Windows Server
2008)

This section explains how to install the PostScript 3 printer driver under Windows Vista/7 or Windows
Server 2008 for use on the IPP port.

1. Quit all applications currently running.

2. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

3. Click [Printers] in [Hardware and Sound].

If using Windows 7, click [View devices and printers].

4. Click [Add a printer].

The [Add Printer] dialog box appears.

5. Click [Add a network, wireless or Bluetooth printer].

6. Click [The printer that I want isn't listed].

Using the IPP Port
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7. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [Close] button.

8. Click [Select a shared printer by name].

9. Enter "http:// machine's IP address/printer (or ipp)" as the machine's address, and then
click [Next].

10. Click [Have Disk...].

11. Click [Browse...], and then specify a location for the inf file.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1".

12. Click [Open].

13. Click [OK] to close the Install From Disk window.

14. Select the machine you want to use, and then click [OK].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

15. Click [Next].

If a check box for setting the machine as a default printer appears, configure as necessary.

16. Specify whether or not to print a test page, and then click [Finish].

If a check box for setting the machine as a default printer appears, configure as necessary.

If installation is successful, the icon of the printer connected to the IPP port is added to the [Printers] or
[Devices and Printers] window.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

1. Windows Configuration
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Using the LPR Port
This section explains how to install the PostScript 3 printer driver for use on the LPR port.

Installing the PostScript 3 Printer Driver (Windows 2000)

This section explains how to install the PostScript 3 printer driver under Windows 2000 for use on the LPR
port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [LPR Port], and then click [Next >].

9. Enter the machine's IP address in the [Name or address of server providing lpd:] box.

10. Enter "Ip" in the [Name of printer or print queue on that server:] box, and then click [OK].

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

13. Specify whether or not to share the machine, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

Using the LPR Port
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15. Click [Finish].

If the [Digital Signature Not Found] message appears, click [Yes].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 /
2003 R2)

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003 /2003 R2 for use on the LPR port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor for Client port.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Click [Create a new port:].

1. Windows Configuration
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8. Click [LPR Port] in [Type of port:], and then click [Next >].

9. Enter the machine's IP address in the [Name or address of server providing lpd:] box.

10. Enter "Ip" in the [Name of printer or print queue on that server:] box, and then click [OK].

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

13. Specify whether or not to share the machine, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

If the [Hardware Installation] message appears, click [Continue Anyway].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista/7, Windows Server
2008)

This section explains how to install the PostScript 3 printer driver under Windows Vista/7 or Windows
Server 2008 for use on the LPR port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor for Client port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Using the LPR Port
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3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Click [Create a new port:], and then click [LPR Port] in [Type of port:].

7. Click [Next].

8. Enter the machine's IP address in [Name or address of server providing lpd:].

9. Enter "Ip" in [Name of printer or print queue on that server:], and then click [OK].

10. Check that the name of the machine whose driver you want to install is selected, and then
click [Next].

11. Change the machine name if you want, and then click [Next].

If a check box for setting the machine as a default printer appears, configure as necessary.

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

12. Specify whether or not to share the machine, and then click [Next].

13. Specify whether or not to print a test page, and then click [Finish].

If a check box for setting the machine as a default printer appears, configure as necessary.

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• Depending on your computer's operating system, the [AutoPlay] dialog box may appear. If this
happens, click [Run SETUP.EXE]. If the [User Account Control] dialog box appears, click [Yes] or
[Continue] to allow the auto play program to run.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

1. Windows Configuration

22

1



Using the WSD Port
This section explains how to install the PostScript 3 printer driver for use on the WSD port.

• The WSD Port can be used under Windows Vista/7, or Windows Server 2008/2008 R2.

• You can connect to the machine only if both the machine and computer are on the same network
segment, or "Network discovery" is enabled. For details, see Windows Help.

Installing the PostScript 3 Printer Driver (Windows Vista, Windows Server 2008)

This section explains how to install the PostScript 3 printer driver under Windows Vista or Windows Server
2008 for use on the WSD port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Click [Start], and then click [Network].

The [Network] window appears, and the device search begins automatically.

3. Right-click the machine's icon, and then click [Install].

If the [User Account Control] dialog box appears, click [Yes] or [Continue].

The [Found New Hardware] dialog box appears.

4. Click [Locate and install driver software (recommended)].

If the [User Account Control] dialog box appears, click [Yes] or [Continue].

5. Click [Browse my computer for driver software (advanced)].

6. Insert the provided CD-ROM into the computer's CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [Close] button.

7. Click [Browse...], and then specify a location for the printer driver.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\PS\
(Language)\XP_VISTA\DISK1".
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8. Click [Next].

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

9. Click [Close].

If installation is successful, the icon of the machine connected to the WSD port is added to the [Printers]
window.

• The port name that follows "WSD" uses random character strings. It cannot be changed freely.

• To stop the installation, click [Cancel] before the installation is complete. When re-installing the WSD
Port, right-click the machine's icon in the [Network] window, and then click [Uninstall].

Installing the PostScript 3 Printer Driver (Windows 7)

This section explains how to install the PostScript 3 printer driver under Windows 7 for use on the WSD
port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. On the [Start] menu, click [Computer].

3. Click [Network].

4. Right-click the machine's icon, and then click [Install].

Driver installation starts automatically.

If the "Device driver software was not successfully installed" message appears, close the message,
and then proceed to step 5.

5. On the [Start] menu, click [Devices and Printers].

6. Click [Add a printer].

7. Click [Add a local printer].

8. Check the [Use an existing port:] check box, and select WSD port.

9. Click [Next].

10. Click [Have Disk...].
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11. Insert the CD-ROM into the CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [Close] button.

12. Click [Browse...], and then specify a location for the printer driver.

If the CD-ROM drive letter is D, the printer driver's source files are stored in "D:\DRIVERS\PS\
(Language)\XP_VISTA\DISK1".

13. Click [OK] to close the [Install From Disk] window.

14. Select the manufacturer and model name of the machine you want to use, and then click
[Next].

15. Follow the instructions on the screens.

According to your needs, you may change the machine name, configure the machine as a default
printer and/or a shared printer, and print a test page.

16. Click [Finish].

If installation is successful, the icon of the printer connected to the WSD port is added to the [Devices
and Printers] window.

• The port name that follows "WSD" uses random character strings. It cannot be changed freely.

• To stop the installation, click [Cancel] before the installation is complete. When re-installing the WSD
Port, right-click the machine's icon in the [Network] window, and then click [Uninstall].
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Using the SmartDeviceMonitor for Client Port
This section explains how to install the PostScript 3 printer driver for use on the SmartDeviceMonitor for
Client port. To use this function, you must first download SmartDeviceMonitor for Client from the
manufacturer's Web site and install it on your computer. Contact your local dealer for information on
downloading SmartDeviceMonitor for Client.

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

This section explains how to install the PostScript 3 printer driver under Windows 2000 for use on the
SmartDeviceMonitor for Client port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of machines using TCP/IP appears.

10. Select the machine you want to use, and then click [OK].

Only machines that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].
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12. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

13. Specify whether or not to share the machine, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

If the [Digital Signature Not Found] message appears, click [Yes].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

This section explains how to install the PostScript 3 printer driver under Windows 2000 for use on the
SmartDeviceMonitor for Client port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].
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8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter "http://(machine's IP address or host name)/printer" as the
machine's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(machine's IP address or host name)/printer" (Internet Explorer 5.01, or a higher version
must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://machine's IP address or host name/ipp" as the machine's address.

If the address is "192.168.001.010", you must enter it as "192.168.1.10" to connect to the machine.

11. Enter a name for identifying the machine in [IPP Port Name]. Use a name different from the
name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to make necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.

13. Click [OK].

14. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

15. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

16. Specify whether or not to share the machine, and then click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

18. Click [Finish].

If the [Digital Signature Not Found] message appears, click [Yes].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 /
2003 R2 - TCP/IP)

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003 /2003 R2 for use on the SmartDeviceMonitor for Client port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor] in [Type of port:], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of machines using TCP/IP appears.

10. Select the machine you want to use, and then click [OK].

Only machines that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

11. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

12. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

13. Specify whether or not to share the machine, and then click [Next >].
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14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

If the [Hardware Installation] message appears, click [Continue Anyway].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 /
2003 R2 - IPP)

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003 /2003 R2 for use on the SmartDeviceMonitor for Client port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Click [Create a new port:].
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8. Click [SmartDeviceMonitor] in [Type of port:], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter "http://(machine's IP address or host name)/printer" as the
machine's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(machine's IP address or host name)/printer" (Internet Explorer 5.01, or a higher version
must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://machine's IP address or host name/ipp" as the machine's address.

If the address is "192.168.001.010", you must enter it as "192.168.1.10" to connect to the machine.

11. Enter a name for identifying the machine in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to make necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.

13. Click [OK].

14. Check that the name of the printer driver you want to install is selected, and then click [OK].

15. Change the name of the machine if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

16. Specify whether or not to share the machine, and then click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

18. Click [Finish].

If the [Hardware Installation] message appears, click [Continue Anyway].

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows Vista/7, Windows Server
2008 - TCP/IP)

This section explains how to install the PostScript 3 printer driver under Windows Vista/7 or Windows
Server 2008 for use on the SmartDeviceMonitor for Client port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Click [Create a new port:], and then select [SmartDeviceMonitor] in [Type of port:].

7. Click [Next].

8. Click [TCP/IP], and then click [Search].

A list of machines using TCP/IP appears.

9. Select the machine you want to use, and then click [OK].

Only machines that respond to a broadcast from the computer appear. To use a machine not listed
here, click [Specify Address], and then enter the IP address or host name of the machine.

10. Check that the name of the machine whose driver you want to install is selected, and then
click [Next].

11. Change the machine name if you want, and then click [Next].

If a check box for setting the machine as a default printer appears, configure as necessary.

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].
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12. Specify whether or not to share the machine, and then click [Next].

13. Specify whether or not to print a test page, and then click [Finish].

If a check box for setting the machine as a default printer appears, configure as necessary.

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• Depending on your computer's operating system, the [AutoPlay] dialog box may appear. If this
happens, click [Run SETUP.EXE]. If the [User Account Control] dialog box appears, click [Yes] or
[Continue] to allow the auto play program to run.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista/7, Windows Server
2008 - IPP)

This section explains how to install the PostScript 3 printer driver under Windows Vista/7 or Windows
Server 2008 for use on the SmartDeviceMonitor for Client port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].
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6. Click [Create a new port:].

7. Click [SmartDeviceMonitor] in [Type of port:], and then click [Next].

8. Click [IPP].

9. In the [Printer URL] box, enter "http://(machine's IP address or host name)/printer" as the
machine's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(machine's IP address or host name)/printer" (Internet Explorer 5.01, or a higher version
must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://machine's IP address or host name/ipp" as the machine's address.

If the address is "192.168.001.010", you must enter it as "192.168.1.10" to connect to the machine.

10. Enter a name for identifying the machine in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

11. Click [Detailed Settings] to make necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.

12. Click [OK].

13. Check that the name of the printer driver you want to install is selected, and then click [Next].

14. Change the name of the machine if you want, and then click [Next].

If a check box for setting the machine as a default printer appears, configure as necessary.

15. Specify whether or not to share the machine, and then click [Next].

16. Specify whether or not to print a test page, and then click [Finish].

If a check box for setting the machine as a default printer appears, configure as necessary.

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• Depending on your computer's operating system, the [AutoPlay] dialog box may appear. If this
happens, click [Run SETUP.EXE]. If the [User Account Control] dialog box appears, click [Yes] or
[Continue] to allow the auto play program to run.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.
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• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout,
recovery/parallel printing, and printer groups.

Windows 2000:

1. Open the [Printers] window from the [Start] menu.

2. Click the icon of the machine you want to use. On the [File] menu, click [Properties].

The printer properties appear.

3. On the [Ports] tab, click [Configure Port...].

The [Port Configuration] dialog box appears.

Windows XP, Windows Server 2003 / 2003 R2:

1. Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

2. Click the icon of the machine you want to use. On the [File] menu, click [Properties].

The printer properties appear.

3. Click the [Ports] tab, and then click [Configure Port...].

The [Port Configuration] dialog box appears.

• User, proxy, and timeout settings can be configured for IPP.

• For information about these settings, see SmartDeviceMonitor for Client Help.

Windows Vista, Windows Server 2008:

1. Open the [Printers] window from [Control Panel] on the [Start] menu.

The [Printers] window appears.

2. Right - click the icon of the machine you want to use, and then click [Properties].

The printer properties appear.
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3. Click the [Port] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• User, proxy, and timeout settings can be configured for IPP.

• For information about these settings, see SmartDeviceMonitor for Client Help.

Windows 7, Windows Server 2008 R2:

1. Open the [Devices and Printers] window from the [Start] menu.

The [Devices and Printers] window appears.

2. Right-click the icon of the printer you want to use, and then click [Printer properties].

The printer properties appear.

3. Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration] dialog box appears.

• User, proxy, and timeout settings can be configured for IPP.

• For information about these settings, see SmartDeviceMonitor for Client Help.

How to enable Recovery/Parallel Printing

If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.

1. Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for
Client icon on the taskbar.

2. Point to [Property], click [Extended Features Settings], and then select the [Set Recovery/
Parallel Printing for each port] check box.

3. Click [OK] to close the [Extended Features Settings] dialog box.

1. Windows Configuration

36

1



Using as a Windows Network Printer
This section explains how to install the PostScript 3 printer driver when using the printer as a Windows
network printer.

Installing the PostScript 3 Printer Driver (Windows 2000)

This section explains how to install the PostScript 3 printer driver under Windows 2000 when using the
printer as a Windows network printer.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• If you print from a print server connected to the machine using the SmartDeviceMonitor for Client port,
Recovery Printing and Parallel Printing cannot be used from the client computer.

• You can install the printer driver from the CD-ROM provided with this printer or download it from the
manufacturer's Web site.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Network printer], and then click [Next >].

7. Select the location method from the [Locate Your Printer] screen, and then click [Next >].

8. Double-click the computer name you want to use as a print server in the [Shared printers:]
window.

9. Select the machine you want to use, and then click [Next >].

10. Click [Next >].

Select [Yes] to configure the machine as default.

11. Click [Finish].

Restart the computer to complete installation.
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• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 /
2003 R2)

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003 /2003 R2 when using the printer as a Windows network printer.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• If you print from a print server connected to the machine using the SmartDeviceMonitor for Client port,
the client cannot use Recovery Printing and Parallel Printing.

• If you print under Windows XP or Windows Server 2003 / 2003 R2 print server, notification functions
of SmartDeviceMonitor may not be used with the client computer.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [A network printer, or a printer attached to another computer] and then click [Next >].

7. Select [Browse for a printer], and then click [Next >].

1. Windows Configuration

38

1



8. Double-click the computer name you want to use as a print server in the [Shared printers:]
window.

9. Select the machine you want to use, and then click [Next >].

If a security warning message appears, click [Yes].

The printer driver installation starts.

10. Click [Next >].

Select [Yes] to configure the machine as default.

11. Click [Finish].

Restart the computer to complete installation.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista/7, Windows Server
2008)

This section explains how to install the PostScript 3 printer driver under Windows Vista/7 or Windows
Server 2008 when using the printer as a Windows network printer.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• If you print from a print server connected to the machine using the SmartDeviceMonitor for Client port,
the client cannot use Recovery Printing and Parallel Printing.

• If you print under Windows Vista/7 or Windows Server 2008 print server, notification functions of
SmartDeviceMonitor may not be used with the client computer.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a network, wireless or Bluetooth printer].

6. Click [The printer that I want isn't listed].

7. Select [Browse for a printer], and then click [Next].

8. Select your machine, and then click [Select].

If a security warning message appears, click [Install driver].

The printer driver installation starts.

9. Check the machine name, and then click [Next].

If a check box for setting the machine as a default printer appears, configure as necessary.

10. Specify whether or not to print a test page, and then click [Finish].

If a check box for setting the machine as a default printer appears, configure as necessary.

The printer driver installation starts.

• To stop installation of the selected driver, click [Cancel] before installation is complete.

• Depending on your computer's operating system, the [AutoPlay] dialog box may appear. If this
happens, click [Run SETUP.EXE]. If the [User Account Control] dialog box appears, click [Yes] or
[Continue] to allow the auto play program to run.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.
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Using as a NetWare Print Server / Remote
Printer
This section explains how to set up a Windows computer used as a NetWare client.

When using the PostScript 3 Printer Driver

This section explains how to set up a Windows computer used as a NetWare client when using the PostScript
3 printer driver.

• In an IPv6 environment, Netware servers cannot be used.

Follow the procedure below to set up the PostScript 3 printer driver.

1. In the [Printers] or [Printers and Faxes] window, open the printer properties.

2. Click the [Device Settings] tab.

3. Select [No] on the [Send CTRL-D Before Each Job:] and [Send CTRL-D After Each Job:], and
then click [Apply].

4. Click [OK] to close the printer properties dialog box.
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Installing the Printer Driver Using USB
This section explains how to install the PostScript 3 printer driver for use over a USB interface.

• Make sure that machine is connected to the computer's USB ports using the USB interface cable.

• Before installing, check that only the operating system is running on the computer and no print jobs
are in progress.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

Windows 2000 - USB

This section explains how to install the PostScript 3 printer driver under Windows 2000 for use over a USB
interface.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

If the printer driver has already been installed, plug and play is enabled, and the icon of the machine
connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the machine to install it from the
CD-ROM provided with this machine.

1. Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

2. Click [Next >].

3. In the Found New Hardware Wizard window, click [Search for a suitable driver for my
device [recommended]], and then click [Next >].

4. Select the [Specify a location] check box, and then click [Next >].

5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

1. Windows Configuration

42

1



6. Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location: D:
\DRIVERS\PS\XP_VISTA\(Language)\DISK1

7. Check the printer driver location, and then click [OK].

8. Click [Next >].

If the [Digital Signature Not Found] message appears, click [Yes].

9. Click [Finish].

If the installation is successful, the icon of the machine connected to the "USB001" port is added to
the [Printers] window.

• The number after "USB" varies depending on the number of machines connected.

Windows XP, Windows Server 2003 / 2003 R2 - USB

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003 / 2003 R2 for use over a USB interface.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

If the printer driver has already been installed, plug and play is enabled, and the icon of the machine
connected to the "USB" port is added to the [Printers and Faxes] window.

The printer drivers can be installed from the CD-ROM provided with this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the machine to install it from the
CD-ROM provided with this machine.

1. Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

2. Select [No, not this time], and then click [Next>].

3. In the Found New Hardware Wizard window, click [Install from a list or specific location
[Advanced]], and then click [Next >].

4. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.
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5. Select the [Include this location in the search] check box under [Search for the best driver in
these locations.], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location: D:
\DRIVERS\PS\XP_VISTA\(Language)\DISK1

6. Check the printer driver location, and then click [Next >].

7. Select the name of the machine whose driver you want to install, and then click [Next >].

If the [Hardware Installation] message appears, click [Continue Anyway].

8. Click [Finish].

If installation is successful, the icon of the machine connected to the "USB001" port is added to the
[Printers and Faxes] window.

• The number after "USB" varies depending on the number of machines connected.

Windows Vista, Windows Server 2008 - USB

This section explains how to install the PostScript 3 printer driver under Windows Vista or Windows Server
2008 for use over a USB interface.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

If the printer driver has already been installed, plug and play is enabled, and the icon of the machine
connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the machine to install it from the
CD-ROM provided with this machine.

1. Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

2. In the Found New Hardware window, select [Locate and install driver software
(recommended)].

Click [Yes] or [Continue] if the [User Account Control] window appears.

3. When a message prompting insertion of the CD-ROM, insert the CD-ROM into the CD-ROM
drive.

If the [AutoPlay] dialog box appears, click the [Close] button.

4. Select the name of the machine whose driver you want to install, and then click [Next].

Installation of the printer driver is automatically started.
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If "Windows can't verify the publisher of this software" display appears in the installation, click [Install
this driver software anyway].

5. Click [Close].

If installation is successful, the icon of this machine connected to the "USB001" port is added to the
[Printers] window.

• When a printer driver meeting this machine is found on a network, a message prompting insertion of
the CD-ROM is not displayed.

• The number after "USB" varies depending on the number of machines connected.

Windows 7 - USB

This section explains how to install the PostScript 3 printer driver under Windows 7 for use over a USB
interface.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

If the printer driver has already been installed, plug and play is enabled, and the icon of the machine
connected to the "USB" port is added to the [Devices and Printers] window.

The printer drivers can be installed from the CD-ROM provided with this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the machine to install it from the
CD-ROM provided with this machine.

1. Connect the machine to the computer using the USB cable.

Connect the USB cable firmly.

2. Click [Devices and Printers] from the [Start] menu.

[Devices and Printers] window appears.

3. In [Unspecified], double-click the name of the machine whose driver you want to install.

4. Click the [Hardware] tab in the printer properties dialog box.

5. Select the name of the machine whose driver you want to install, and then click [Properties].

6. Click [Change settings].

7. Click the [Driver] tab.

8. Insert the CD-ROM into the CD-ROM drive.

If the [AutoPlay] dialog box appears, click the [Close] button.

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

9. Click [Update Driver...].
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10. Click [Browse my computer for driver software].

11. Click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location: D:
\DRIVERS\PS\XP_VISTA\(Language)\DISK1

12. Click [Next].

If "Windows can't verify the publisher of this software" display appears in the installation, click [Install
this driver software anyway].

13. Click [Close].

If installation is successful, the icon of this machine connected to the "USB001" port is added to the
[Devices and Printers] window.

• The number after "USB" varies depending on the number of machines connected.

Troubleshooting for Using USB

The following table explains general problems you might encounter and their solutions when installing the
printer drivers for use over a USB interface.

Problems Solutions

The machine is not automatically recognized.
Turn off the power of the machine, reconnect the
USB cable, and then turn it on again.

Windows has already configured the USB settings.

Open Windows' Device Manager, and then
remove any conflicting devices under [Universal
Serial Bus controllers] or [USB Controller].
Conflicting devices have a yellow [!] or [?] icon by
them. Take care not to accidentally remove
required devices. For details, see Windows Help.
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Printing with Parallel Connection
This section explains how to install the PostScript 3 printer driver for use over a parallel port.

To use a machine connected using a parallel interface, click [LPT1] when installing the printer driver.

Installing the PostScript 3 printer driver (Windows 2000)

This section explains how to install the PostScript 3 printer driver under Windows 2000 for use over a
parallel port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Select [LPT1:] under [Use the following port:], and then click [Next >].

8. Select the name of the machine whose driver you want to install, and then click [Next >].

9. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

10. Select whether or not to share the machine, and then click [Next >].

11. Select whether or not you want to print a test page, and then click [Next >].

12. Click [Finish].

If the [Digital Signature Not Found] message appears, click [Yes].

The printer driver installation starts.

13. Restart the computer to complete installation if necessary.
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• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 /
2003 R2)

This section explains how to install the PostScript 3 printer driver under Windows XP or Windows Server
2003 /2003 R2 for use over a parallel port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Select the port you want to use, and then click [Next >].

A dialog box for selecting the machine manufacturer and model name appears.

8. Select the name of the machine whose driver you want to install, and then click [Next >].

9. Change the machine name if you want, and then click [Next >].

Select [Yes] to configure the machine as default.

10. Select whether or not to share the machine, and then click [Next >].
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11. Specify whether or not to print a test page, and then click [Next >].

12. Click [Finish].

If the [Hardware Installation] message appears, click [Continue Anyway].

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows Vista/7, Windows Server
2008)

This section explains how to install the PostScript 3 printer driver under Windows Vista/7 or Windows
Server 2008 for use over a parallel port.

• Manage Printers permission is required to install the driver. Log on as an Administrators group member.

• You can install the printer driver from the CD-ROM provided with this machine or download it from
the manufacturer's Web site.

• If you are using the 64-bit version of an operating system, download the printer driver from the
manufacturer's Web site. Select this machine and the operating system you are using, and then
download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Add a local printer].

6. Select the port you want to use, and then click [Next].

A dialog box for selecting the machine manufacturer and model name appears.

7. Select the name of the machine whose driver you want to install, and then click [Next].
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8. Change the machine name if you want, and then click [Next].

If a check box for setting the machine as a default printer appears, configure as necessary.

The printer driver installation starts.

If the [Windows can't verify the publisher of this driver software] message appears, click [Install this
driver software anyway].

9. Specify whether or not to share the machine, and then click [Next].

10. Specify whether or not to print a test page, and then click [Finish].

If a check box for setting the machine as a default printer appears, configure as necessary.

• Depending on your computer's operating system, the [AutoPlay] dialog box may appear. If this
happens, click [Run SETUP.EXE]. If the [User Account Control] dialog box appears, click [Yes] or
[Continue] to allow the auto play program to run.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.
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If a Message Appears during Installation
Message number 58 or 34 indicates the printer driver cannot be installed using Auto Run. Install the printer
driver using [Add Printer] or [Install Printer].

For Windows 2000:

1. On the [Start] menu, point to [Settings], and then click [Printers].

2. Double-click the Add Printer icon.

3. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1.

For Windows XP Professional and Windows Server 2003 / 2003 R2:

1. On the [Start] menu, click [Printers and Faxes].

2. Click [Add a printer].

3. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1.

For Windows XP Home Editions:

1. On the [Start] menu, click [Control Panel].

2. Click [Printers and Other Hardware].

3. Click [Printers and Faxes].

4. Click [Install Printer].

5. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1.

For Windows Vista and Windows Server 2008:

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".

3. Click [Add a printer].

4. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1.
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For Windows 7:

1. On the [Start] menu, click [Control Panel].

2. Click [Hardware and Sound].

3. Click [Add a printer].

4. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the PostScript 3 printer driver is D:\DRIVERS\PS
\XP_VISTA\(Language)\DISK1.

• If the installer starts, click [Cancel] to quit.
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Making Option Settings for the Printer
Make option settings for the machine using the printer driver when bidirectional communication is disabled.

Set up option settings when bidirectional communications are disabled.

• Manage Printers permission is required to change the printer properties. Log on as an Administrators
group member.

1. On the [Start] menu, click [Printers and Faxes].

• When using Windows 2000, point to [Settings] on the [Start] menu, and then click [Printers].

• When using Windows Vista or Windows Server 2008, click [Control Panel] on the [Start] menu,
and then click [Printer] in "Hardware and Sound".

• When using Windows 7 or Windows Server 2008 R2, click the [Start] menu, and then click
[Devices and Printers].

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

• When using Windows Vista or Windows Server 2008, right-click the icon of the printer you
want to use, and then click [Properties].

• When using Windows 7 or Windows Server 2008 R2, right-click the icon of the printer you
want to use, and then click [Printer properties].

4. Click the [Device Settings] tab.

5. Select options installed from the [Installable Options] area, and then make the necessary
settings.

6. Click [Apply], and then click [OK] to close the printer properties dialog box.

• For details about making option settings for the machine using a Mac, see "Setting Up Options for
Mac OS X".

• p.62 "Setting Up Options for Mac OS X"

Making Option Settings for the Printer

53

1



Setting Up the Printer Driver
This section explains how to open and configure the printer driver properties.

Windows 2000 - Accessing the Printer Properties

This section explains how to open and configure the printer driver properties under Windows 2000.

Making printer default settings - the printer properties

This section explains how to open the printer driver properties under Windows 2000.

• Manage Printers permission is required to change the printer properties. Log on as an Administrators
group member.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The printer properties dialog box appears.

4. Make the necessary settings, and then click [OK].

• Depending on the applications, the settings you make here may not be used as the default settings.

• Do not make a setting for [Form to Tray Assignment].

• For details, see the printer driver Help.

Making printer default settings - Printing Preferences

This section explains how to open the [Printing Preferences] dialog box under Windows 2000.

• When the printer driver is distributed from the print server, the setting values specified by the server
are displayed as the default for [Printing Defaults...].

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
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2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

The setting is temporarily registered as [Unregistered] in the [One Click Preset List:] area.

• Depending on the applications, the settings you make here may not be used as the default settings.

• The [Unregistered] setting is invalid when the other One Click Presets icon is selected. If you wish to
confirm the [Unregistered] setting, click [Register Current Settings...]. For details about confirming the
setting, see "Making Printer Settings - One Click Presets".

• For details, see the printer driver Help.

• p.60 "Making Printer Settings - One Click Presets"

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application.

The following explains how to make settings for the WordPad application.

1. Open the application.

2. On the [File] menu, click [Print...].

The [Print] dialog box appears.

3. Select the printer you want to use in the [Select Printer] list, and then click the tab for the
settings you want to change.

4. Make the necessary settings, and then click [Apply].

5. Click [Print].

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Depending on the applications, the printer default settings may not be applied.

• The printer settings you configure in the current application before printing might not be saved as the
default settings.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.
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• For details, see the printer driver Help.

Windows XP, Windows Server 2003 / 2003 R2 - Accessing the Printer Properties

This section explains how to open and configure the printer driver properties under Windows XP or
Windows Server 2003 / 2003 R2.

Making printer default settings - the printer properties

This section explains how to open the printer driver properties under Windows XP or Windows Server
2003 / 2003 R2.

• Manage Printers permission is required to change the printer properties. Log on as an Administrators
group member.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The printer properties dialog box appears.

4. Make the necessary settings, and then click [OK].

• Depending on the applications, the settings you make here may not be used as the default settings.

• Do not make a setting for [Form to Tray Assignment].

• For details, see the printer driver Help.

Making printer default settings - Printing Preferences

This section explains how to open the [Printing Preferences] dialog box under Windows XP or Windows
Server 2003 / 2003 R2.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.

• When the printer driver is distributed from the print server, the setting values specified by the server
are displayed as the default for [Printing Defaults...].
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1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

The setting is temporarily registered as [Unregistered] in the [One Click Preset List:] area.

• Depending on the applications, the settings you make here may not be used as the default settings.

• The [Unregistered] setting is invalid when the other One Click Presets icon is selected. If you wish to
confirm the [Unregistered] setting, click [Register Current Settings...]. For details about confirming the
setting, see "Making Printer Settings - One Click Presets".

• For details, see the printer driver Help.

• p.60 "Making Printer Settings - One Click Presets"

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following explains how to make settings for the WordPad application provided with
Windows XP.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list, and then click [Preferences].

3. Make the necessary settings, and then click [OK].

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Depending on the applications, the printer default settings may not be applied.

• The printer settings you configure in the current application before printing might not be saved as the
default settings.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details, see the printer driver Help.
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Windows Vista/7, Windows Server 2008/2008 R2 - Accessing the Printer
Properties

This section explains how to open and configure the printer driver properties under Windows Vista/7 or
Windows Server 2008/2008 R2.

Making printer default settings - the printer properties

This section explains how to open the printer driver properties under Windows Vista/7 or Windows Server
2008/2008 R2.

• Manage Printers permission is required to change the printer properties. Log on as an Administrators
group member.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".

• If using Windows 7, click [View devices and printers] in "Hardware and Sound".

• If using Windows Server 2008 R2, click [View devices and printers] in "Hardware".

3. Right-click the icon of the printer you want to use, and then click [Properties].

If using Windows 7 or Windows Server 2008 R2, right-click the icon of the printer you want to use,
and then click [Printer properties].

4. Make the necessary settings, and then click [OK].

• Depending on the applications, the settings you make here may not be used as the default settings.

• Do not make a setting for [Form to Tray Assignment].

• For details, see the printer driver Help.

Making printer default settings - Printing Preferences

This section explains how to open the [Printing Preferences] dialog box under Windows Vista/7 or
Windows Server 2008/2008 R2.

• You cannot change the printer default settings for each user. Settings made in the printer properties
dialog box are applied to all users.
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• When the printer driver is distributed from the print server, the setting values specified by the server
are displayed as the default for [Printing Defaults...].

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".

• If using Windows 7, click [View devices and printers] in "Hardware and Sound".

• If using Windows Server 2008 R2, click [View devices and printers] in "Hardware".

3. Right-click the icon of the printer you want to use, and then click [Printing Preferences...].

If using Windows 7 or Windows Server 2008 R2, right-click the icon of the printer you want to use,
and then click [Printing preferences].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

The setting is temporarily registered as [Unregistered] in the [One Click Preset List:] area.

• Depending on the applications, the settings you make here may not be used as the default settings.

• The [Unregistered] setting is invalid when the other One Click Presets icon is selected. If you wish to
confirm the [Unregistered] setting, click [Register Current Settings...]. For details about confirming the
setting, see "Making Printer Settings - One Click Presets".

• For details, see the printer driver Help.

• p.60 "Making Printer Settings - One Click Presets"

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following explains how to make settings for the WordPad application.

1. On the [File] menu, click [Print...].

If using Windows 7 or Windows Server 2008 R2, on the [File] menu, point to [Print], and then click
[Print].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list, and then click [Preferences].

3. Make the necessary settings, and then click [OK].
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• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Depending on the applications, the printer default settings may not be applied.

• The printer settings you configure in the current application before printing might not be saved as the
default settings.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details, see the printer driver Help.

Making Printer Settings - One Click Presets

This section explains how to register and use one click presets.

Each function explained in this chapter is preconfigured and registered under [One Click Preset List:] on
the [One Click Presets] tab.

You can apply the relevant setting simply by clicking on the one click preset name. This helps to avoid
incorrect settings and misprints.

One click presets can be added, modified, and deleted as required. By using registered one click presets,
users without in-depth knowledge of the printer driver can utilize advanced printing functions easily.

Follow the procedure to register one click presets.

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the machine, and then open the [Printing Preferences] dialog box in the document's
native application.

The [Printing Preferences] dialog box appears.

3. Make the settings you require.

4. Click [Register Current Settings...]. Enter a name and comment that describe the setting, and
then click [OK].

The newly registered icon appears with its registered name in the [One Click Preset List:] area.

5. Click [OK].

• For details about modifying and deleting one click presets, see the printer driver Help.
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2. Mac OS Configuration
This chapter explains how to install and configure the printer drivers for use on the Mac OS X operating
system.

Using the Printer Driver under Mac OS X
This section explains how to configure a Mac OS X to use USB and TCP/IP.

Use the following procedures to configure the printer drivers for Mac OS X 10.3.7. The procedures vary
depending on the operating system.

• Mac OS X 10.2 or higher is required.

• The PPD files are stored in the following folder on the CD-ROM.

Mac OS X: MacOSX PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

• You need an administrator name and a password (phrase). For details, consult your network
administrator.

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS X] folder.

4. Double-click the manufacturer folder for your machine model.

5. Double-click the [MAC OS X 10.2 or later] or [MAC OS X 10.5 or later] folder, depending
on your operating system.

6. Double-click the [MacOSX PPD Installer] folder.

7. Double-click the package file icon.

8. Follow the instructions on the screen.

Setting Up the PPD Files

This section explains how to add the PPD file to your system.
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1. Start System Preferences.

2. Click [Print & Fax].

3. Click [Set Up Printers].

Depending on your computer's operating system, [Set Up Printers] may not appear. If [Set Up Printers]
does not appear, proceed to the following step.

4. Click the [Add] or [ ] button.

5. Select [IP Printing] from the drop-down menu, and then select the machine from the list.

Mac OS X 10.5 or higher

Click [IP].

Mac OS X 10.4

Click [IP Printer].

6. In [Printer Address], type the machine's IP address. Select [LPD/LPR] for [Printer Type], and
leave the queue blank.

Mac OS X 10.4 or higher

Enter machine's IP address in the [Address:] box. Select [LPD] as the protocol, and leave the
queue blank.

7. Select the connected printer from the list of printer models, and then click [Add].

If [Installable Options] dialog box appears, configure settings as needed, and then click [Continue].

8. Quit System Preferences.

Setting Up Options for Mac OS X

This section explains how to configure the printer driver.

1. Start System Preferences.

2. Click [Print & Fax].

3. Click [Set Up Printers].

Depending on your computer's operating system, [Set Up Printers] may not appear. If [Set Up Printers]
does not appear, proceed to the following step.

4. Select the machine you are using, and then click [Show Info].

Mac OS X 10.5 or higher

Select the machine you are using, and then click [Options & Supplies...].

Mac OS X 10.4

Select the machine you are using, and then click [Printer Setup].
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5. Select [Installable Options] in the drop-down menu, and then configure settings as needed.

Mac OS X 10.5 or higher

Click [Driver], and then configure settings as needed.

6. Click [Apply Changes].

Mac OS X 10.5 or higher

Click [OK].

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Using USB Interface

Follow the procedure below to set up USB connection.

• USB2.0 can be used only with Mac OS X 10.3.3 or higher.

1. Start System Preferences.

2. Click [Print & Fax].

3. Click [Set Up Printers].

Depending on your computer's operating system, [Set Up Printers] may not appear. If [Set Up Printers]
does not appear, proceed to the following step.

4. Click the [Add] or [ ] button.

Mac OS X 10.5 or higher

Click [Default].

Mac OS X 10.4

Click a printer that has "USB" indicated in the "Connection" column.

Other Mac OS X

Click [USB] on the pop-up menu.

The connected printer appears.

5. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4, select the printer you are using from the [Print Using] pop-up menu.

A list of printer types appears.

Under Mac OS X 10.5 or higher, select the printer you are using from the [Printer Name] list, and
[Kind] of USB.

6. Select the connected printer from the list of printer models, and then click [Add].

Using the Printer Driver under Mac OS X
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7. Quit System Preferences.

• When printing with a USB connection to a Macintosh computer, printer language does not change
automatically. Use the control panel on this machine to change printer language to [Auto Detect] or
[PS] before printing.

Using Bonjour

Follow the procedure below to print using Bonjour under Mac OS X 10.2.3 or higher. Mac OS X 10.3.7
is used as the example of the procedure. Ethernet, wireless LAN connections can also be used.

1. Start System Preferences.

2. Click [Print & Fax].

3. Click [Set Up Printers].

Depending on your computer's operating system, [Set Up Printers] may not appear. If [Set Up Printers]
does not appear, proceed to the following step.

4. Click the [Add] or [ ] button.

Mac OS X 10.5 or higher

Click [Default]. If the machine name is not displayed, select the icon that corresponds to your
network environment (TCP/IP, etc.).

Mac OS X 10.4

Click a printer that has "Bonjour" indicated in the "Connection" column.

Other Mac OS X

Click [Rendezvous] on the pop-up menu.

5. Select the name of the connected printer from the [Printer Model:] pop-up menu, and then
click [Add].

Under Mac OS X 10.4, Installable Options window appears. Select the option you want to set up,
and then select an appropriate setting for it, and then [Continue].

Under Mac OS X 10.5 or higher, select the printer you are using from the [Printer Name] list, and
[Kind] of Bonjour.

6. Quit System Preferences.

• When printing with a Rendezvous connection to a Macintosh computer, printer language does not
change automatically. Use the control panel on this machine to change printer language to [Auto
Detect] or [PS] before printing.
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3. Using the PostScript 3 Printer Driver
This chapter explains the printing functions and advanced features that are available with the PostScript 3
printer driver.

Setting Up Options for PostScript 3 Printer Driver
To use installed options correctly, first set up the printer driver. If the options are not recognized, you cannot
use them, even though they are physically installed.

• Manage Printers permission is required to change the printer properties. Log on as an Administrators
group member.

• If you are using Adobe PageMaker 6.0, 6.5, or 7.0, you have to set up options in Adobe PageMaker's
print dialog box.

The following table shows where you can set up a printer driver on each operating system.

The procedure to set up a printer driver varies depending on the operating system.

Windows XP and Mac OS X 10.5 are used as examples of their respective operating system families.

Windows operating system
You can set up any of the options on [Installable
Options] on the [Device Settings] tab in the Printer
Properties.

Mac OS X
You can set up all options on [Options & Supplies...]
in [Print & Fax] in System Preferences.

• To set up options, access the printer driver from Windows. You cannot set up options if you access
the printer driver from an application.

• See "Making Option Settings for the Printer" or "Setting Up Options for Mac OS X" for the installation
method appropriate to your printing environment.

• p.53 "Making Option Settings for the Printer"

• p.62 "Setting Up Options for Mac OS X"
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Printing a Document
This documentation describes the specific printer functions and menus that are added by installing the PPD
file.

Each printer function can be configured using the [Menu:] icons on the [Detailed Settings] tab under
Windows, or the print dialog box under Mac OS X.

Windows XP and Mac OS X 10.5 are used as examples of their respective operating system families.
Procedures for other versions of these operating systems may vary slightly.

• On a Macintosh, Mac OS X 10.2 or higher is required.

• Applications, such as PageMaker, that have their own drivers do not support the following functions:

• Sample Print

• Locked Print

• Hold Print

• Stored Print

• Store and Print

• Document Server

• User Code

• Depending on the version of Mac OS X, the display in the print dialog box may be different.

• If you are using the Windows operating system, some of the settings made on the [Detailed Settings]
tab can be registered to One Click Preset List. The settings registered in One Click Preset List can be
modified from the [One Click Presets] tab also. For details about One Click Presets, see "Making
Printer Settings - One Click Presets".

• p.60 "Making Printer Settings - One Click Presets"

Job Type

Use this to select the type of print job.

The following table shows where you can select this function.

Windows
[Job Type:] is displayed on the [One Click Presets]
tab in the [Printing Preferences] dialog box.
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Mac OS X
[Job Type:] is displayed on [Job Log] in the print
dialog box.

You can select the following items:

Normal Print

Select this for normal printing. The print job starts immediately after the print command is given.

Sample Print

Use this function to print only one set of a multiple print jobs.

The other sets are saved in the machine. The saved job can be printed from the machine's control
panel. You can also delete the saved job.

The "User ID" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

Entering the "User ID" helps you distinguish your print job from others.

For details about the Sample Print function, see "How to use the Sample Print function".

Locked Print

Use this function to save documents in the machine memory with a password, and then edit and print
them as you want.

The "User ID" can contain to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password" must be
4-8 digits.

Entering the "User ID" helps you distinguish your print job from others.

For details about the Locked Print function, see "How to use the Locked Print function".

Hold Print

Use this function to temporarily hold a file in the machine, and print it from the computer or the machine's
control panel later.

The "User ID" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

The "File Name" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

Entering the "User ID" helps you distinguish your print job from others.

For details about the Hold Print function, see "How to use the Hold Print function".

Stored Print

Use this function to store a file in the machine, and then print it from the computer or the machine's
control panel later.

The "User ID" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password" must
be 4-8 digits.

The File Name can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

You can assign a password to a saved document, but password assignment is not mandatory.

Entering the "User ID" helps you distinguish your print job from others.
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For details about the Stored Print function, see "How to use Stored Print/Store and Print functions".

Store and Print

Use this function to print the file at once and also store the file in the printer.

The "User ID" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password" must
be 4-8 digits.

The "File Name" can contain up to 16 alphanumeric (a-z, A-Z, 0-9) characters.

You can assign a password to a saved document, but password assignment is not mandatory.

Entering the "User ID" helps you distinguish your print job from others.

For details about the Stored and Print function, see "How to use Stored Print/Store and Print functions".

Document Server

Use this function to store documents that you want to print in the printer, as well as documents you
might want to later combine or process for printing.

The "File Name" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

For details about the Document Server function, see "Accessing the Document Server", Printer
Reference.

• p.68 "How to use the Sample Print function"

• p.71 "How to use the Locked Print function"

• p.74 "How to use the Hold Print function"

• p.76 "How to use Stored Print/Store and Print functions"

How to use the Sample Print function

Follow the procedure below to print a document using the Sample Print function.

Windows

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. On the [One Click Presets] tab, in the [Job Type:] list, click [Sample Print].

4. Click [Details...].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

The user ID associates the user with his / her jobs.

6. Click [OK].
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7. Set the number of copies to two or more in the [Copies:] box, and then click [OK] to close
the [Printing Preferences] dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Sample Print jobs by default. If the collate option is selected in
the application's [Print] dialog box, there may be more prints than required.

8. Start the printing from the application's [Print] dialog box.

The sample print job is sent to the machine, and one set is printed.

9. Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps to print the remaining sets.

If you want to delete saved jobs, see "Deleting Sample Print files".

10. On the machine's control panel, press the [Printer] key to display the printer screen.

11. Press [Print Jobs].

12. Press [Sample Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

13. Select the file you want to print by pressing it.

14. Press [Print].

15. Enter the new number of sets using the number keys if necessary, and then press [Yes].

You can enter up to 999 sets.

Press the [Clear/Stop] key to correct any entry mistakes.

When multiple files are selected without setting a quantity, 1 page less than the minimum number of
all settings is applied.

The remaining sets are printed.

Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Set the number of copies to two or more.

The sample print job is sent to the machine, and one set is printed.

3. In the pop-up menu, click [Job Log].

4. On the [Job Type:] pop-up menu, select [Sample Print].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

The user ID associates the user with his / her jobs.
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6. After making the necessary settings, click [Print].

7. Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps to print the remaining sets.

If you want to delete saved jobs, see "Deleting Sample Print files".

8. On the machine's control panel, press the [Printer] key to display the printer screen.

9. Press [Print Jobs].

10. Press [Sample Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

11. Select the file you want to print by pressing it.

12. Press [Print].

13. Enter the new number of sets using the number keys if necessary, and then press [Yes].

You can enter up to 999 sets.

Press the [Clear/Stop] key to correct any entry mistakes.

When multiple files are selected without setting a quantity, 1 page less than the minimum number of
all settings is applied.

The remaining sets are printed.

• To cancel printing, press [Exit]. Then, press [Job Reset]. The file will be deleted.

• If there is a print job outstanding, this is printed before the sample print job.

• When printing is completed, the stored file is deleted automatically.

• p.70 "Deleting Sample Print files"

Deleting Sample Print files

If the printed document is no longer required, you can delete the Sample Print file.

1. On the machine's control panel, press the [Printer] key to display the printer screen.

2. Press [Print Jobs].

3. Press [Sample Print Job List].

A list of print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.
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4. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted jobs again.

5. Press [Delete].

A confirmation screen appears.

6. Press [Yes] to delete the file.

The selected file is deleted.

• Press [No] to cancel the delete request.

How to use the Locked Print function

Follow the procedure below to print a document using the Locked Print function.

Windows

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. On the [One Click Presets] tab, in the [Job Type:] list, click [Locked Print].

4. Click [Details...].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box.

The user ID associates user with his / her jobs.

6. Click [OK].

7. Click [OK] to close the [Printing Preferences] dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Locked Print jobs by default. If the collate option is selected in the
application's [Print] dialog box, there may be more prints than required.

8. Start the printing from the application's [Print] dialog box.

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the documents, see "Deleting Locked Print files".

9. On the machine's control panel, press the [Printer] key to display the printer screen.

10. Press [Print Jobs].

11. Press [Locked Print Job List].

A list of print files stored in the machine appears.
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[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

12. Select the file you want to print by pressing it.

13. Press [Print].

The password screen appears.

14. Enter the password using the number keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Exit] to enter the
password again.

When multiple print files are selected, the machine prints only files that correspond to the entered
password. The number of files is displayed on the confirmation screen.

15. Press [Yes].

The locked file is printed.

Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Locked Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box.

The user ID associates the user with his / her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the documents, see "Deleting Locked Print files".

6. On the machine's control panel, press the [Printer] key to display the printer screen.

7. Press [Print Jobs].

8. Press [Locked Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

9. Select the file you want to print by pressing it.
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10. Press [Print].

The password screen appears.

11. Enter the password using the number keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Exit] to enter the
password again.

When multiple print files are selected, the machine prints only files that correspond to the entered
password. The number of files is displayed on the confirmation screen.

12. Press [Yes].

The locked file is printed.

• To cancel printing, press [Exit]. Then, press [Job Reset]. The file will be deleted.

• When printing is completed, the stored file is deleted automatically.

• p.73 "Deleting Locked Print files"

Deleting Locked Print files

If the printed document is no longer required, you can delete the Locked Print file.

1. On the machine's control panel, press the [Printer] key to display the printer screen.

2. Press [Print Jobs].

3. Press [Locked Print Job List].

A list of print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

4. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted job again.

5. Press [Delete].

A password screen appears.

6. Enter the password using the number keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will reappear if the password was entered incorrectly. Press [Exit] to enter the
password again.

When multiple files are selected, the machine deletes only files that correspond to the entered
password. The number of files to be deleted is displayed on the confirmation screen.
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7. Press [Yes].

The selected file is deleted.

• Press [No] to cancel the delete request.

• If you forgot your password, ask your file administrator for help.

How to use the Hold Print function

Follow the procedure below to print a document using the Hold Print function.

Windows

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. On the [One Click Presets] tab, in the [Job Type:] list, click [Hold Print].

4. Click [Details...].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name can also be entered arbitrarily.

The user ID associates the user with his / her jobs.

6. Click [OK].

7. Click [OK] to close the [Printing Preferences] dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Hold Print files by default. If a collate option is selected from the
application's Print dialog box, there may be more prints than required.

8. Start the printing from the application's [Print] dialog box.

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the documents, see "Deleting Hold Print files".

9. On the machine's control panel, press the [Printer] key to display the printer screen.

10. Press [Print Jobs].

11. Press [Hold Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

12. Select the file you want to print by pressing it.
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13. Press [Print].

14. A confirmation screen appears.

15. Press [Yes].

The hold print file is printed.

Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Hold Print].

4. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name can also be entered arbitrarily.

The user ID associates the user with his / her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the documents, see "Deleting Hold Print files".

6. On the machine's control panel, press the [Printer] key to display the printer screen.

7. Press [Print Jobs].

8. Press [Hold Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

9. Select the file you want to print by pressing it.

10. Press [Print].

A confirmation screen appears.

11. Press [Yes].

The hold print file is printed.

• To cancel printing, press [Exit]. Then, press [Job Reset]. The file will be deleted.

• When printing is completed, the stored file is deleted automatically.

• p.76 "Deleting Hold Print files"
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Deleting Hold Print files

If the printed document is no longer required, you can delete the Hold Print file.

1. On the machine's control panel, press the [Printer] key to display the printer screen.

2. Press [Print Jobs].

3. Press [Hold Print Job List].

A list of print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

4. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted job again.

5. Press [Delete].

A confirmation screen appears.

6. Press [Yes].

The selected file is deleted.

• Press [No] to cancel the delete request.

How to use Stored Print/Store and Print functions

Follow the procedure below to print a document using the Stored Print/Store and Print functions.

Windows

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. On the [One Click Presets] tab, in the [Job Type:] list, click [Stored Print] or [Store and Normal
Print].

• Stored Print

Stores the file in the printer and print it later using the control panel.

• Store and Normal Print

Prints the file at once and also stores the file in the machine.

4. Click [Details...].

5. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name and password can also be entered arbitrarily.

The user ID associates the user with his / her job.
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You can assign a password to a saved document, but password assignment is not mandatory.

The same password must be entered when printing or deleting.

6. Click [OK].

7. Click [OK] to close the [Printing Preferences] dialog box.

If the application has a collate option, make sure it is not selected before sending a print job. The
printer driver automatically collates Stored Print files by default. If a collate option is selected from the
application's Print dialog box, there may be more prints than required.

8. Start the printing from the application's [Print] dialog box.

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the documents, see "Deleting Stored Print files".

9. On the machine's control panel, press the [Printer] key to display the printer screen.

10. Press [Print Jobs].

11. Press [Stored Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

12. Select the file you want to print by pressing it.

13. Press [Print].

A confirmation screen appears.

If you have already set a password, proceed to the following step.

14. Enter a password using the number keys on the password screen, and then press [OK].

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

If you have not set the password, proceed to the following step.

15. Enter the new number of sets using the number keys if necessary, and then press [Yes].

You can enter up to 999 sets.

Press the [Clear/Stop] key to correct any entry mistakes.

The stored file is printed.

Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].
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3. On the [Job Type:] pop-up menu, click [Stored Print] or [Store and Print].

• Stored Print

Stores the file in the printer and print it later using the control panel.

• Store and Print

Prints the file at once and also stores the file in the machine.

4. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name and password can also be entered arbitrarily.

The user ID associates the user with his / her jobs.

You can assign a password to a saved document, but password assignment is not mandatory.

The same password must be entered when printing or deleting.

5. After making the necessary settings, click [Print].

The document file is saved in the machine.

To print the document, perform the following steps.

To delete the documents, see "Deleting Stored Print files".

6. On the machine's control panel, press the [Printer] key to display the printer screen.

7. Press [Print Jobs].

8. Press [Stored Print Job List].

A list of print files stored in the machine appears.

[User ID], [Date / Time] and [File Name] also appear.

Depending on the security settings, certain print jobs may not be displayed.

9. Select the file you want to print by pressing it.

10. Press [Print].

A confirmation screen appears.

If you have already set a password, proceed to the following step.

11. Enter a password using the number keys on the password screen, and then press [OK].

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

If you have not set the password, proceed to the following step.

12. Enter the new number of sets using the number keys if necessary, and then press [Yes].

You can enter up to 999 sets.

Press the [Clear/Stop] key to correct any entry mistakes.

The stored file is printed.

• To cancel printing, press [Exit]. Then, press [Job Reset]. The file will be deleted.
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• Stored Print file sent to the machine is not deleted unless you delete them in the machine or select [Auto
Delete Stored Print Jobs]. For details about the [Auto Delete Stored Print Jobs] settings, see "System",
Printer Reference. For details about deleting stored files, see "Deleting Stored Print files".

• p.79 "Deleting Stored Print files"

Deleting Stored Print files

If the printed document is no longer required, you can delete the Stored Print files.

1. On the machine's control panel, press the [Printer] key to display the printer screen.

2. Press [Print Jobs].

3. Press [Stored Print Job List].

A list of print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

4. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted job again.

5. Press [Delete].

A confirmation screen appears.

6. Enter a password using the number keys on the password screen, and then press [OK].

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

If you have not set the password, proceed to the following step.

7. Press [Yes].

The selected file is deleted.

• Press [No] to cancel the delete request.

• If you have already set a password in the printer driver, enter it to delete.

• If you forgot your password, ask your file administrator for help.

How to use the Document Server function

Follow the procedure below to print a document using the Document Server function.
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Windows

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer, and then open the [Printing Preferences] dialog box.

3. In the [Job Type:] list, click [Send to Document Server].

4. Click [Details...].

5. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name and password can also be entered arbitrarily.

The user ID associates the user with his / her job.

You can assign a password to a saved document, but password assignment is not mandatory.

The same password must be entered when printing or deleting.

6. Click [OK].

7. Click [OK] to close the printer properties dialog box.

8. Start the printing from the application's [Print] dialog box.

Mac OS X

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Document Server].

4. In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. A file name and password can also be entered arbitrarily.

The user ID associates the user with his / her job.

You can assign a password to a saved document, but password assignment is not mandatory.

The same password must be entered when printing or deleting.

5. Start the printing from the application's [Print] dialog box.

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to check
the number of sheets printed under each code with SmartDeviceMonitor for Admin.

The following table shows where you can select this function.
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Windows

Enter a user code in the [User Code:] box on the

[Job Setup] menu in the [Printing Preferences]
dialog box.

Mac OS X
Select the [Enable User Code] check box, and then
enter a user code in the [User Code:] box on [Job
Log] in the print dialog box.

• For details about using SmartDeviceMonitor for Admin, see SmartDeviceMonitor for Admin Help.

Orientation

Use this to set the paper orientation.

The following table shows where you can select this function.

Windows
[Orientation:] is displayed on the [Basic] menu in
the [Printing Preferences] dialog box.

Mac OS X [Orientation:] is displayed in the print dialog box.

You can select the following items:

• Portrait

• Landscape

• Rotated Landscape

• If you are using a Mac OS X, click to select the button that means "Landscape" or "Portrait".

• Under Mac OS X, "Rotated Landscape" cannot be selected.

Color Mode

Use this to select whether the document is printed in color or black and white.

The following table shows where you can select this function.

Windows
[Color Mode] is displayed on the [Basic] menu in
the [Printing Preferences] dialog box.
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Mac OS X

[Color Mode] is displayed under [General 1] in the

[Feature Sets:] list on [Printer Features] in the print
dialog box.

You can select the following items:

Color

Prints color documents in full color.

Black and White

Prints everything, including color documents, in black and white. Black and White printing is faster
than Color printing. To stop black and white areas being printed with CMYK toner, select [Black and
White] in the printer driver as well as in the application.

• Color images will be printed using CMYK toner, Cyan, Magenta, Yellow and Black. CMYK are three
primary subtractive colors.

• If you want to adjust the print color, adjust the color settings. For details, see "Color Control".

• p.91 "Color Control"

Rotate by 180 degrees

Use this to rotate the print image by 180 degrees.

The following table shows where you can select this function.

Windows
Check the [Rotate by 180 degrees:] check box on
the [Basic] menu in the [Printing Preferences] dialog
box.

Mac OS X
[Rotate by 180 degrees] is displayed under
[General 3] in the [Feature Sets:] list on [Printer
Features] in the print dialog box.

Copies

Use this function to specify the number of copies to print.

The following table shows where you can select this function.
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Windows
[Copies:] is displayed on the [Basic] menu in the
[Printing Preferences] dialog box.

Mac OS X [Copies:] is displayed in the print dialog box.

Paper Size

Use this to select the size of paper you want to use.

The following table shows where you can select this function.

Windows
[Paper Size:] is displayed on the [Basic] menu in
the [Printing Preferences] dialog box.

Mac OS X [Paper Size] is displayed in the print dialog box.

• For details about the paper sizes supported by this machine, see "System Settings", Network and
System Settings Reference.

Reduce/Enlarge

Use this function to specify a scaling mode for reducing or enlarging the print size of documents.

The following table shows where you can select this function.

Windows
[Reduce/Enlarge] is displayed on the [Basic] menu
in the [Printing Preferences] dialog box.

Mac OS X This function is not available.

You can select the following items for Windows:

Full Size

Prints the document at its original size.

Scale To Fit

Prints the document by scaling it up or down to fit the specified paper size.

Scale

Prints the document at the specified reproduction ratio.
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Paper Source

Use this to select a paper tray.

The following table shows where you can select this function.

Windows
[Paper Source:] is displayed on the [Paper] menu
in the [Printing Preferences] dialog box.

Mac OS X
[All pages from:] is displayed on [Paper Feed] in
the print dialog box.

• For details about paper trays, see "Loading Paper", About This Machine.

Media Type

Use this to select the paper type.

The following table shows where you can select this function.

Windows
[Media Type:] is displayed on the [Paper] menu in
the [Printing Preferences] dialog box.

Mac OS X
[Paper Type] is displayed under [General 3] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

• For details about paper types available in each tray, see "Recommended Paper Sizes and Types",
About This Machine.

Fit to Paper

When the size of the document and paper size differ, set whether or not to print according to paper size.

The following table shows where you can select this function.

Windows
[Fit to Paper] is displayed on the [Paper] menu in
the [Printing Preferences] dialog box.
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Mac OS X
[Fit to Paper] is displayed under [General 1] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

Prompt User

Print is performed with the size of document to be printed unchanged.

Nearest Size and Scale

If the paper size is smaller than the selected paper size, the driver reduces the print size.

If the paper size is larger than the size of document to be printed, print is not to fit the paper size.

Nearest Size and Crop

Print is performed regardless of any differences between selected and actual paper size. However,
the print output is not adjusted to fit the paper size.

Pages per Sheet/ Booklet

Use this function to specify the number of pages to be printed on a single sheet of paper. Under the Windows
operating system, you can also specify booklet printings.

The following table shows where you can select this function.

Windows

[Pages per Sheet:] is displayed on the [Edit] menu
in the [Printing Preferences] dialog box.

If you want to specify booklet printings, select
[Booklet] in the [Pages per Sheet:] list.

Mac OS X

[Pages per Sheet:] is displayed on [Layout] in the
print dialog box.

The booklet printing is not available.

Layout

Use this function to specify the layout when printing multiple pages onto a single sheet of paper.

The following table shows where you can select this function.

Windows
[Pages per Sheet Layout:] is displayed on the [Edit]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Layout] is displayed in the list in the print dialog
box.
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• If you are using a Mac OS X, click to select the button.

Booklet Binding Edge

Use this function to specify image layout order when [Layout] is specified.

The following table shows where you can select this function.

Windows
[Booklet Binding Edge:] is displayed on the [Edit]
menu in the [Printing Preferences] dialog box.

Mac OS X This function is not available.

Page Order

Use this function to specify image layout order when [Layout] is specified.

The following table shows where you can select this function.

Windows
[Pages per Sheet Layout:] is displayed on [Edit]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Page Order:] is displayed on [Paper Handling] in
the print dialog box.

• Depending on the version of the Mac OS X operating system, this function may not be available.

Draw Border

Use this function to specify whether or not to draw a page border on each page.

The following table shows where you can select this function.

Windows
Check the [Draw Border] check box on the [Edit]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Border:] is displayed on [Layout] in the print dialog
box.
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Duplex Printing

Use this function to select duplex printing.

The following table shows where you can select this function.

Windows
[Duplex:] is displayed on the [Edit] menu in the
[Printing Preferences] dialog box.

Mac OS X
Check the [Two-Sided] check box in the print
dialog box.

Windows

The following items may vary depending on the operating system you are using.

Off

Disables Duplex Printing.

Long Edge

Prints output so that you can open it to the long edge when bound along the long edge.

Short Edge

Prints output so that you can open it to the short edge when bound along the short edge.

Mac OS X

The following functions are selectable under Mac OS X 10.3 or higher (for Mac OS X 10.2, see Note
below). The following items may vary depending on the operating system you are using.

Off

Disables Duplex Printing.

Long-edge binding

Prints output so that you can open it to the long edge when bound along the long edge.

Short-edge binding

Prints output so that you can open it to the short edge when bound along the short edge.

• If you are using a Mac OS X 10.2, click to select the button that means "Flip on Long Edge" or "Flip
on Short Edge".
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Resolution

Use this to set the resolution types.

The following table shows where you can select this function.

Windows
[Resolutions:] is displayed on the [Print Quality]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Resolution:] is displayed under [General 1] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

• For more information about the resolution types, see the printer driver Help.

Gradation

Use this to select a type of gradation based on your purpose.

The following table shows where you can select this function.

Windows
[Gradation:] is displayed on the [Print Quality]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Gradation] is displayed under [General 1] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

• For details about the gradation types, see the printer driver Help.

Dithering

Use this to set the Image Rendering mode.

The following table shows where you can select this function.

Windows
[Dithering:] is displayed on the [Print Quality] menu
in the [Printing Preferences] dialog box.
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Mac OS X
[Dithering] is displayed under [General 2] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

You can select the following items:

Auto

Use this setting to configure the best dithering method automatically depending on the appearance
of the document to be printed.

Photographic

Performs dithering using an appropriate pattern for photographs.

Text

Performs dithering using an appropriate pattern for text.

User Setting

Use this setting to print images set in half tone in your application.

Image Smoothing

Use this to select the image smoothing type.

The following table shows where you can select this function.

Windows
[Image Smoothing:] is displayed on the [Print
Quality] menu in the [Printing Preferences] dialog
box.

Mac OS X
[Image Smoothing] is displayed under [General 1]
in the [Feature Sets:] list on [Printer Features] in the
print dialog box.

You can select the following items:

Off

Disables image smoothing.

On

Performs image smoothing unconditionally.

Auto

Performs image smoothing automatically for images that have a resolution less than 25% of supported
printer resolution.
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Less than 90 ppi to Less than 300 ppi

Performs image smoothing only when the image has an image resolution (pixels per inch) less than
the respective value you have selected in the list.

• When [Auto] is selected, data processing may take a long time.

• When Image Smoothing is used for a mask image, this function may have an undesired effect on the
print result.

Gray Reproduction

Use this to select the Black Color mode for text and line art.

The following table shows where you can select this function.

Windows
Click [Details...] on the [Print Quality] menu to open
a dialog, and then select the item in the [Gray
Reproduction:] list.

Mac OS X
[Gray Reproduction (Text/Line Art)] is displayed
under [General 2] in the [Feature Sets:] list on
[Printer Features] in the print dialog box.

You can select the following items:

Black/Gray by K

Prints black and gray text and graphics using black toner only.

Black by K

Prints black text and graphics using black toner only.

CMY+K

Prints black and gray text and graphics using all toner colors.

Black/Gray by K (Text only)

Prints black and gray text using black toner only.

Black by K (Text only)

Prints black text using black toner only.

Black Over Print

Select whether or not to apply a black color over any other colors when printing.

The following table shows where you can select this function.
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Windows
Click [Details...] on the [Print Quality] menu to open
a dialog, and then click the [Black Over Print:]
check box.

Mac OS X
[Black Over Print:] is displayed under [General 2]
in the [Feature Sets:] list on [Printer Features] in the
print dialog box.

Color Control

Use this to select whether or not you want the colors in the documents to be adjusted before printing so that
the printed page matches closer to the colors on the screen.

The following table shows where you can select this function.

Windows
Click [Details...] on the [Print Quality] menu to open
a dialog, and then select the items in the [ICM
Method:] and [ICM Intent:] lists.

Mac OS X Select [Color Matching] in the print dialog box.

ColorSync

Select this item to specify the color management system for Mac OS X.

ICM Method:

Select this item to specify the color management system for the Windows operating system.

Color Setting

Use this to select the correction method used for color conversion.

The following table shows where you can select this function.

Windows
Click [Details...] on the [Print Quality] menu to open
a dialog, and then select the item in the [Color
Setting] list.

Mac OS X
[Color Setting] is displayed under [General 2] in
the [Feature Sets:] list on [Printer Features] in the
print dialog box.

You can select the following items:
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Off

No modification to the color setting.

Fine

Select this setting to perform color matching based on one of the printer's built- in color rendering
dictionaries and perform CMYK conversion. This setting performs the printing which output target is
Monitor Gamma= 1.8.

Super Fine

Select this setting to use a color rendering dictionary as in the [Fine] setting but produce output that is
more vivid. Use this setting to emphasize light colors. This setting performs the printing which output
target is Monitor Gamma= 2.2.

• The color rendering dictionary that is selected in the [Color Profile] setting is used.

Color Profile

Use this to select the color profile pattern.

The following table shows where you can select this function.

Windows
Click [Details...] on the[ Print Quality] menu to open
a dialog, and then select the item in the [Color
Profile:] list.

Mac OS X
[Color Profile] is displayed under [General 2] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

You can select the following items:

Auto

Use this setting to configure the best color profile pattern automatically depending on the appearance
of the document to be printed.

Photographic

Use this setting to enhance the reproduction of photos and graphics that include midtones.

Presentation

Use this setting to enhance the reproduction of documents that contain text and graphics. This CRD is
best for printing colored charts, graphs, presentation materials and so on. If you use this CRD for
printing photographs, the color or gradations might not be reproduced well.
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Solid Color

Use this setting to print specific colors, logos and so on.

User Setting

Use this setting to print images with downloaded CRD from your application.

CLP Simulation1

Use this setting to print blue color more brightly and vividly.

CLP Simulation2

Use this setting to print blue color more brightly and vividly. Print results are lighter than those of CLP
Simulation1.

Enable ICM Processing

Use this setting to enable image color management. This setting is only available under a Windows
operating system.

• Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
should select the appropriate CRD for the document you are printing. The selected CRD is also referred
to when [Fine] or [Super Fine] is selected for [Color Setting]: The following items are available: [Auto],
[Photographic], [Presentation] and [Solid Color].

Separate into CMYK

Use this to select the print separation type.

You can separate the printing data into CMYK to specify a specific color combination.

The following table shows where you can select this function.

Windows
Click [Details...] on the [Print Quality] menu to open
a dialog, and then select the item in the [Separate
into CMYK] list.

Mac OS X
[Separate into CMYK] is displayed under [General
2] in the [Feature Sets:] list on [Printer Features] in
the print dialog box.

CMYK Simulation Profile

You can simulate the color tone of the printing ink.

You can select the printing ink from US OffsetPrint, Euroscale, JapanColor, and PaletteColor.

The following table shows where you can select this function.
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Windows
Click [Details...] on the[ Print Quality] menu to open
a dialog, and then select the item in the [CMYK
Simulation Profile:] list.

Mac OS X
[CMYK Simulation Profile] is displayed under
[General 3] in the [Feature Sets:] list on [Printer
Features] in the print dialog box.

Print Mode/ Toner Saving

Use this to select the toner saving mode.

The following table shows where you can select this function.

Windows
[Print Mode:] is displayed on the [Print Quality]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Print Mode] is displayed under [General 1] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

Barrier-free Color Management

Use this function to enable enhanced color output for color vision impaired users.

The following table shows where you can select this function.

Windows
[Barrier-free Color Management:] is displayed on
the [Print Quality] menu in the [Printing Preferences]
dialog box.

Mac OS X This function is not available.

Destination

Use this to select an output tray.

The following table shows where you can select this function.

Windows
[Destination:] is displayed on the [Finishing] menu
in the [Printing Preferences] dialog box.

3. Using the PostScript 3 Printer Driver

94

3



Mac OS X
[Destination] is displayed under [General 3] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

• For details about output trays supported by this machine, see "Output Tray Settings (Type 1 and 2)"
or "Output Tray Settings (Type 3 and 4)", Network and System Settings Reference.

Collate

Use this function to enable collation. With this feature, the machine can efficiently print collated sets of
multiple-page documents.

The following table shows where you can select this function.

Windows

Set the number of copies to two or more on the
[Basic] menu, and then select [On] or [Off] on the
[Collate:] list on the [Finishing] menu in the [Printing
Preferences] dialog box.

Mac OS X
Check the [Collated] check box in the printer dialog
box.

Page Output Order

Specify the order of pages to print.

The following table shows where you can select this function.

Windows
[Page Output Order] is displayed on the [Finishing]
menu in the [Printing Preferences] dialog box.

Mac OS X
Select [Reverse] in [Page Order:] on [Paper
Handling] in the print dialog box.

Orientation Override

Use this to set the paper orientation.

The following table shows where you can select this function.
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Windows
[Orientation Override:] is displayed on the
[Finishing] menu in the [Printing Preferences] dialog
box.

Mac OS X
[Orientation Override] is displayed under
[General 4] in the [Feature Sets:] list on [Printer
Features] in the print dialog box.

You can select the following items:

• Off

• Landscape

• Portrait

Staple

Use this function to staple sheets of printed paper together.

• When stapling, use the finisher option. See "System Settings", Network and System Settings Reference
or "Printing Documents", Printer Reference.

The following table shows where you can select this function.

Windows
[Staple:] is displayed on the [Finishing] menu in the
[Printing Preferences] dialog box.

Mac OS X
[Staple] is displayed under [General 3] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

• The stapling position might differ depending on the paper orientation set on the machine and the
orientation of the data to be printed. For details, see Printer Reference.

Punch

Use this function to punch holes in the printed documents.

• When stapling, use the finisher option. See "System Settings", Network and System Settings Reference
or "Printing Documents", Printer Reference.
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The following table shows where you can select this function.

Windows
[Punch:] is displayed on the [Finishing] menu in the
[Printing Preferences] dialog box.

Mac OS X
[Punch] is displayed under [General 3] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

• Punch positions and the number of punch holes that are available will change depending on the type
of finisher, the original's orientation, and the printing paper size and orientation. For details, see Printer
Reference.

Watermark

Set the Watermark function.

The following table shows where you can select this function.

Windows
[Watermark:] is displayed on the [Effects] menu in
the [Printing Preferences] dialog box.

Mac OS X
[Watermark:] is displayed under [General 4] in the
[Feature Sets:] list on [Printer Features] in the print
dialog box.

Watermark Text

Select the Watermark Text type.

The following table shows where you can select this function.

Windows
[Watermark Text:] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Text] is displayed under [General 4]
in the [Feature Sets:] list on [Printer Features] in the
print dialog box.
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Watermark Font

Select the Watermark Font type.

The following table shows where you can select this function.

Windows
[Watermark Font:] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Font] is displayed under [General 4]
in the [Feature Sets:] list on [Printer Features] in the
print dialog box.

Watermark Size

Select the Watermark size.

The following table shows where you can select this function.

Windows
[Watermark Size:] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Size] is displayed under [General 4]
in the [Feature Sets:] list on [Printer Features] in the
print dialog box.

Watermark Angle

Select the Watermark angle.

The following table shows where you can select this function.

Windows
[Watermark Angle:] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Angle] is displayed under [General 4]
in the [Feature Sets:] list on [Printer Features] in the
print dialog box.

Watermark Style

Select the Watermark style.
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The following table shows where you can select this function.

Windows
[Watermark Style:] is displayed on the [Effects]
menu in the [Printing Preferences] dialog box.

Mac OS X
[Watermark Style] is displayed under [General 5]
in the [Feature Sets:] list on [Printer Features] in the
print dialog box.
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4. Appendix

Trademarks
Adobe, Acrobat, Acrobat Reader, Adobe Type Manager, PageMaker, PostScript, and Reader are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

Apple, Bonjour, Macintosh, Mac OS and TrueType are registered trademarks of Apple Inc., registered in
the United States and other countries.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks by
Ricoh Company, Ltd. is under license.

Microsoft®, Windows®, Windows Server®, and Windows Vista® are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

• The product names of Windows XP are as follows:

Microsoft® Windows® XP Professional Edition

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Media Center Edition

Microsoft® Windows® XP Tablet PC Edition

• The product names of Windows Vista are as follows:

Microsoft® Windows® Vista Ultimate

Microsoft® Windows® Vista Business

Microsoft® Windows® Vista Home Premium

Microsoft® Windows® Vista Home Basic

Microsoft® Windows® Vista Enterprise

• The product names of Windows 7 are as follows:

Microsoft® Windows® 7 Home Premium

Microsoft® Windows® 7 Professional

Microsoft® Windows® 7 Ultimate

101

4



Microsoft® Windows® 7 Enterprise

• The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

• The product names of Windows Server 2003 R2 are as follows:

Microsoft® Windows Server® 2003 R2 Standard Edition

Microsoft® Windows Server® 2003 R2 Enterprise Edition

• The product names of Windows Server 2008 are as follows:

Microsoft® Windows Server® 2008 Standard

Microsoft® Windows Server® 2008 Enterprise

• The product names of Windows Server 2008 R2 are as follows:

Microsoft® Windows Server® 2008 R2 Standard

Microsoft® Windows Server® 2008 R2 Enterprise
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